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ВВЕДЕНИЕ 

 

 

Итак, дорогой читатель, добро пожаловать в мир компьютерной верстки. 

Что же вас ожидает на страницах этой книги? 

Сегодня уже практически никого не надо убеждать в том, что офисные пакеты с 

поддержкой сложного форматирования (например, Microsoft Word) хороши для 

ведения деловой переписки, а для создания качественного полиграфического про-

дукта нужны специализированные издательские системы. Издательская система, в 

отличие от сколь угодно мощного текстового редактора, ориентирована на типо-

графское (или качественное экранное для электронных публикаций) воспроизведе-

ние результата. Следовательно, они снабжены инструментами, обычно не востре-

бованными в офисных задачах: системами управления цветом, средствами тонкой 

настройки характеристик шрифта (точный, заказной и ручной кернинг и трекинг), 

треппинга, возможностью произвольно, с высокой точностью располагать элемен-

ты макета на странице и т. д. 

Все это хорошо известно, и специальных пояснений не требует. Нам же остается 

самая приятная и интересная задача: разобраться, как именно создавать публикации 

своей мечты с помощью новейшей версии одного из лучших на сегодня издатель-

ских пакетов — InDesign CS5. 

Для кого эта книга? 

 Вы давно мечтали научиться создавать красивые страницы, буклеты и целые 

книги, но не знали, как к этому подойти? Тогда эта книга — для вас! Подробные 

описания всех основных инструментов, команд, настроек и алгоритмов позволят 

шаг за шагом пройти от первого знакомства до уверенной работы в программе. 

Пошаговое выполнение заданий и работа с проектами позволят набрать необхо-

димые навыки, а постоянное упоминание горячих клавиш для часто используе-

мых команд поможет научиться действовать быстро и эффективно. 

 Вы неплохо владеете программами компьютерной графики (Photoshop, 

Illustrator и т. д.) и хотели бы расширить свой профессиональный диапазон, до-

бавив к нему навыки верстальщика? Тогда эта книга — для вас! Многие элемен-

ты интерфейса Adobe InDesign похожи на то, что вам знакомо по другим паке-

там, поэтому здесь вы будете чувствовать себя, как дома. Тем не менее InDesign 

ни в коей мере не "близнец" любой из этих программ. Важные отличия есть как 
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в интерфейсе, так и в задачах и инструментах. Например, InDesign имеет бога-

тейший набор средств контроля подготовки макета к печати, исключительно 

удобную организацию работы с многостраничными документами и т. д. Освоив 

InDesign и сравнив процесс и готовый макет с версткой, например, в пакете 

Adobe Illustrator, вы обнаружите, что результат стоил затраченных усилий. 

 Вы опытный верстальщик, работавший до сих пор в других программах верст-

ки (Adobe PageMaker, QuarkXPress и др.)? Тогда эта книга — для вас! Освоив-

шись в новом интерфейсе и приятно удивившись многим симпатичным и облег-

чающим работу новинкам, вы сможете использовать эту книгу как надежного 

проводника и консультанта в процессе знакомства с пакетом и как справоч-

ник — потом. Кроме обычных пояснений, что и как выглядит и действует в про-

грамме, здесь приводятся различные интересные алгоритмы и подходы, позво-

ляющие заметно оптимизировать работу и добиваться интересных результатов 

с минимальной затратой сил. 

Что нужно знать, чтобы эффективно освоить 

программу с помощью этой книги? 

Разумеется, прежде всего, нужно знать графический интерфейс используемой опе-

рационной системы. InDesign CS5 работает как с ОС Windows XP и выше, так и с 

MacOS. Горячие клавиши и клавиатурные сочетания для всех основных действий 

будут указываться для обеих платформ. 

Естественно, предполагается, что вы умеете работать в каком-либо текстовом  

редакторе, например Microsoft Word. Базовые знания и навыки работы с текс- 

том заметно упростят задачу освоения многих инструментов и возможностей 

InDesign CS5. 

Для выполнения практических заданий необходимо иметь на компьютере установ-

ленную программу Adobe InDesign CS5. В процессе мы для удобства будем исполь-

зовать системные и широко распространенные шрифты, а в дальнейшем вы сможе-

те при желании пополнить свои шрифтовые наборы. 

 Заменяет ли эта книга обучение на соответствующих курсах? Строго говоря, 

конечно, нет. На курсах есть возможность попросить разъяснения, получить 

комментарий преподавателя, задать вопрос. Эффективность усвоения материала 

на курсах обычно выше, чем при самостоятельном изучении. Но книга построе-

на на основе "привязки" прочитанного к увиденному в окне программы и пред-

полагает пошаговую проработку проектов на основе материалов с компакт-

диска и выполнение самостоятельных заданий на предложенные темы. В ре-

зультате вы по окончании работы с книгой будете вполне готовы к работе в ка-

честве верстальщика полиграфических или интерактивных публикаций. Разуме-

ется, очень желательно работать с книгой последовательно, в порядке изложе-

ния материала, поскольку каждый следующий проект в той или иной мере 

использует знания и навыки, полученные при работе с предыдущим. 
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 Возможно ли изучать InDesign с помощью этой книги, имея на компьютере 

программу одной из предыдущих версий (CS2, CS3, CS4)? К сожалению, нет. Во-

первых, запись из версии CS5 в формат более старых версий невозможна, в этом 

пакете есть совместимость только "снизу вверх". Во-вторых, самые элементар-

ные действия и основные палитры, конечно, мало меняются от версии к версии, 

но программа в целом изменилась даже относительно версии CS4 очень заметно. 

Многие возможности, рассматриваемые в книге, в старых версиях программы 

попросту недоступны. 

 Какие вопросы рассматриваются в книге? Прежде всего, это интерфейс про-

граммы, ее инструменты, команды и другие возможности. Каждый элемент про-

граммы рассматривается в привязке к остальным ее частям и практическим за-

дачам, выполняемым с его помощью. По мере необходимости даются некоторые 

сведения о компьютерной графике вообще и работе с ней. Также приводится не-

обходимая терминология, связанная с предпечатной подготовкой макетов. 

У книги нет задачи подготовить специалистов по пре-прессу, поэтому сложные 

вопросы, связанные с тонкостями цветоделения, треппинга и других сугубо тех-

нических процессов, не рассматриваются. 

 Как организуется практическая работа с книгой? Каждое практическое задание 

представляет собой проект — набор действий и материалов, позволяющий 

пройти путь от создания файла публикации с заданными параметрами до гото-

вого документа. Все материалы проекта находятся на диске в папке с соответст-

вующим названием, например "Project1_City". Описание действий приводится в 

тексте книги, в разделе, посвященном проекту. В первых главах пошаговые ин-

струкции максимально подробны, в дальнейшем они становятся более сжатыми, 

обозначая действия, но не детализируя их вплоть до нажатия на отдельную кла-

вишу. Предполагается, что в проектах, рассматриваемых в последних главах, вы 

используете навыки, полученные ранее. 
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Глава 1 
 

 

ЧТО НОВОГО В ПРОГРАММЕ? 

 

 

 

 
 
Эта глава настоятельно рекомендуется к прочтению пользователям предыдущих 

версий, которые хотят легко и безболезненно перейти на версию CS5 и сразу на-

чать активно пользоваться ее преимуществами. 

Версия InDesign CS5 значительно отличается от прежних, и не только по внешнему 

виду, характерному для всего пакета CS5. Появились новые инструменты и воз-

можности, изменилось расположение многих команд, которые теперь размещены  

в более естественных для них разделах меню. Заметно расширены разделы, связан-

ные с разработкой электронных публикаций, многое сделано для автоматизации и 

повышения комфортности работы. 

Дизайн  

и работа с публикациями 

InDesign — прежде всего, программа для подготовки макетов печатных публика-

ций, и больше всего новинок мы найдем именно в этой области. 
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Использование разных форматов страниц в одном документе 

Теперь можно определить несколько форматов страницы в пределах одного доку-

мента. Эта возможность очень полезна, например когда идет работа над целым 

блоком небольших документов в рамках единого проекта: если, скажем, нужно от-

форматировать в едином стиле деловое письмо, открытку, конверт и т. д. Теперь не 

требуется создавать отдельную публикацию для каждого из этих документов. 

Для создания специфического формата страницы достаточно выделить эту страни-

цу инструментом Page Tool (Страница) и настроить нужный формат в контрольной 

панели (рис. 1.1). 
 

 

Рис. 1.1. Изменение формата отдельной страницы 

 

Новая палитра Layers (Слои) 

Палитра Layers (Слои) стала значительно удобнее и функциональнее (рис. 1.2). 

Появились такие же, как в Illustrator, треугольные маркеры раскрытия/свора-

чивания содержимого слоя, возможность скрыть/показать или заблокировать/ 

разблокировать как слой целиком, так и отдельные его элементы. Действия по ре-

шению этих задач, как и изменение порядка расположения слоев и элементов внут-

ри слоя, в InDesign теперь совершенно аналогичны применяемым в Illustrator, что 

заметно облегчает и ускоряет работу при параллельном использовании этих двух 

программ. 

Расширение списка доступных форматов при создании нового документа 

Если вы часто используете формат страницы, отсутствующий в списке доступных 

форматов нового документа, его теперь можно быстро и легко добавить. Для этого 

просто при создании нового документа выберите в выпадающем списке форматов  
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Рис. 1.2. Новая палитра Layers 

Custom page size (Задать новый формат) и в соответствующем диалоговом окне 
определите новый элемент списка, задав ему имя и размеры. 

Новые возможности трансформации 

Заметно изменились инструменты трансформации, приблизившись к аналогичным 

инструментам в программах Adobe Photoshop и Adobe Illustrator. Например, нако-
нец-то появилась возможность поворачивать объекты в режиме Bounding Box (Га-

баритный контейнер), не вызывая для этого инструмент поворота; появились новые 
интересные возможности у инструмента Free Transform; скругление углов геомет-

рических форм теперь тоже можно задать прямо в режиме габаритного контейнера. 

"Захват содержимого" 

Эта функция внешне отображается как полупрозрачный круг, появляющийся в цен-
тре импортированной картинки при наведении на нее инструмента Черная стрел-

ка (рис. 1.3). Щелчком по этому кругу активизируются возможности трансформа-
ции содержимого фрейма, прежде доступные только при использовании Пустой 

стрелки. Таким образом, можно работать с самим фреймом или с его содержимым, 
не меняя инструмента. 

При желании эту функцию можно отключить, выбрав в главном меню View > 

Extras > Hide Content Grabber (Вид > Дополнительно > Скрыть захват содержи-
мого). 

Двойной щелчок мышью 

Двойной щелчок левой кнопкой мыши по импортированному изображению теперь 
не создает перехода с инструмента Selection (Черная стрелка) на инструмент Direct 

Selection (Пустая стрелка), а переключает фокус выделения с фрейма на его содер-
жимое и обратно. Аналогично, если нужно выделить объект в группе, достаточно 
двойного щелчкa на этом объекте. Для возврата к выделению группы нужно сде-
лать двойной щелчок на границе любого входящего в группу объекта. 
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Рис. 1.3. Изображение в режиме "захвата содержимого" 

Преимущество нового подхода в том, что при всех этих действиях активным инст-

рументом остается Черная стрелка, и по окончании работы с содержимым фрейма 

или элементом группы не требуется смена инструмента. 

Подсветка границ фрейма 

В режиме "скрытых границ" (Hide frame edges) при наведении курсора на тот или 

иной объект его границы временно подсвечиваются (рис. 1.4), что дает уверенность 

в том, что вы собираетесь выделить именно тот объект, который нужен, и при этом 

позволяет не загромождать экран разноцветной сеткой из границ объектов. Цвет 

подсветки определяется цветом, присвоенным слою, на котором находится объект. 

 

Рис. 1.4. Подсветка контуров в режиме скрытых границ 
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Подсветка контуров и точек 

При наведении на объект инструмента Пустая стрелка подсвечиваются сегменты 

и точки, составляющие его контур, что заметно упрощает выбор элементов для ре-
дактирования формы объекта. 

Трансформация нескольких объектов одновременно 

Теперь не нужно (наконец-то!) создавать группу всякий раз, когда требуется изме-

нить размер или повернуть несколько объектов одновременно. Просто выделите 
все необходимые объекты и пользуйтесь их общим габаритным контейнером. Схе-

ма действий обычная: простое перемещение маркеров изменяет размер фрейма или 

поворачивает его, применение клавиши <Shift> позволяет изменять размер с сохра-
нением пропорций или поворачивать объект на углы, кратные 45°, <Alt> — произ-

водить трансформацию "от центра". Применение клавиши <Ctrl> позволяет транс-
формировать не только фрейм, но и его содержимое. 

"Живая" прорисовка экрана 

При перемещении содержимого фрейма его новое расположение относительно 

фрейма и соседних объектов отображается "на лету" (рис. 1.5), позволяя вам кор-
ректировать свои действия без дополнительной паузы. 

 

Рис. 1.5. Перерисовка экрана в процессе работы с изображением 

"Живое" распределение объектов 

Иногда бывает необходимо изменить расстояние между элементами страницы, не 
изменяя их собственных размеров. Теперь для этого достаточно выбрать нужные 

объекты и начать масштабирование, удерживая клавишу <Пробел>. 

Инструмент Gap Tool (Просвет) 

Новый инструмент, позволяющий быстро настроить расстояние между двумя или 

более объектами и управлять внешним видом страницы на основе "пустого про-
странства", что сейчас является весьма популярным подходом к построению стра-

ниц. 
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Новое в работе с текстом 

Текст — основа любой публикации. Усовершенствованные средства работы с тек-

стом заметно облегчают и ускоряют процесс создания макета. 

Абзацы с разнообразным делением на колонки 

Теперь можно работать с многоколоночными структурами, не создавая отдельных 

текстовых фреймов для каждой колонки. В пределах одного текстового фрейма 

можно для каждого абзаца создать его собственную структуру — в одну, две или 

более колонок (рис. 1.6). 
 

 

Рис. 1.6. Абзац сложной структуры 

 

Связка с предыдущим абзацем 

В диалоговом окне Keep Options (Параметры связки) теперь появилась команда 

Keep With Previous (Связка с предыдущим), позволяющая запретить отрыв первой 

строки текущего абзаца от последней строки предыдущего. 

Баланс колонок 

Новая установка в диалоговом окне Text Frame Options (Параметры текстового 

фрейма) позволяет автоматически создать равномерное распределение текста в 

многоколоночном фрейме. 

Вертикальное выравнивание текста во фреймах сложной формы 

До сих пор размещение текста во фрейме сложной формы означало, что установки 

вертикального выравнивания будут проигнорированы. Теперь можно задавать вер-

тикальное выравнивание текста во фреймах любой формы. 
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Новое в работе с объектами 

Небольшие, но удобные усовершенствования окажут ощутимую помощь в повсе-

дневной работе. 

Вызов палитры образцов из контрольной панели 

В новой версии чрезвычайно изящно решена проблема поиска баланса между необ-

ходимостью иметь под рукой палитру образцов и высвобождением максимального 

пространства для работы. Теперь палитру Swatches (Образцы) для каждого атрибу-

та можно вызвать из контрольной панели (рис. 1.7). Кстати, при этом снимается 

необходимость помнить, какой атрибут активен, обычно отвлекающая внимание от 

основного процесса: для каждого атрибута — своя кнопка вызова палитры, которая 

разворачивается тут же, от контрольной панели, и сворачивается после выбора об-

разца. 

 

Рис. 1.7. Вызов образцов для каждого атрибута из контрольной панели 

Кроме того, текущий образец можно присвоить любому объекту на странице про-

стым перетаскиванием (но тут уже надо следить за атрибутом: при перетаскивании 

образца внутрь объекта он будет присвоен заливке, если же подтащить его к грани-

це — обводке). 
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Автоматическое "табличное" размещение импортированных изображений 

При импорте нескольких изображений их теперь можно автоматически разместить 

"табличкой", чтобы все они одновременно оказались в поле зрения (рис. 1.8). Для 

этого определите с помощью мыши область размещения и, удерживая клавишу 

<Ctrl>, клавишами-стрелками на клавиатуре задайте количество строк/столбцов 

(клавиши < >, < > управляют столбцами, < >, < > — строками). 

 

Рис. 1.8. "Табличное" размещение импортированных изображений 

Опция Auto-Fit (Автонастройка) 

Новая опция, позволяющая автоматически подгонять размер импортированной 

картинки при изменении размера фрейма. Удобна, прежде всего, тем, что в этом 

режиме не требуется удерживать <Ctrl> при трансформировании импортированных 

изображений. 

 "Табличное" размещение группы фреймов в процессе их создания 

При создании фрейма (текстового или обычного) можно задать сразу целую группу 

однотипных фреймов и разместить их "таблично" (колонками и рядами). Для этого 

достаточно во время использования любого подходящего инструмента задать об-

ласть размещения группы и, не отпуская мышь, клавишами-стрелками на клавиату-

ре задать количество строк/столбцов (клавиши действуют так же, как при размеще-

нии импортированных картинок). 
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Подписи на основе метаданных 

InDesign CS5 позволяет создавать подписи под рисунками на основе метаданных, 

причем тут есть несколько способов. 

Можно дать команду на создание подписей прямо в процессе импорта, активизиро-

вав установку Create Static Captions (Создать подписи) в диалоговом окне коман-

ды Place (Импорт) (рис. 1.9). 
 

 

Рис. 1.9. Установка Create Static Captions в диалоговом окне Place 

 

Можно создавать подписи к уже импортированным изображениям. Для этого сна-
чала в контекстном меню объекта нужно выбрать Captions (Подписи) > Caption 

Setup (Настройка подписи) и задать шаблон подписи, в том числе выбрать необхо-
димые метаданные. Следующий шаг — Captions (Подписи) > Generate Live 

Caption (Создать активную подпись) или Generate Static Caption (Создать стати-
ческую подпись). 

Активная подпись отличается от статической тем, что она жестко привязана к изо-

бражению. При попытке отодвинуть ее в текстовом поле появляется надпись 
Nonintersective link (Нет пересечения с изображением). При изменении исполь- 

зуемых метаданных подпись тоже изменяется. Статическая подпись после созда- 
ния уже не меняется и позволяет любое перемещение относительно "своей" кар-

тинки. 

Mini Bridge 

Mini Bridge — часть приложения Adobe Bridge, выделенная в отдельный блок и 

доступная в пределах InDesign CS5 в виде палитры (рис. 1.10). В ней, как и в 

"большом" Bridge, отображается файловая система с традиционным "деревом  

папок", файлы показываются в виде миниатюр, размер и взаимное расположение  
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которых можно настраивать. Работают основные функ-

ции Bridge, вроде вызова по двойному щелчку мыши 

"родной" программы для редактирования того или ино-

го файла. В результате работа с внешними файлами 

(текстами, изображениями) становится такой же лег-

кой, как при использовании "большого" Bridge, но про-

исходит это "не выходя из дома" (т. е. из пакета 

InDesign). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Рис. 1.10. Mini Bridge 

 

Дополнительная интеграция  
с Adobe Bridge 

InDesign CS5 и Adobe Bridge CS5 получили дополнительные возможности взаимо-

действия. 

Миниатюры страниц 

Новая команда File Handling (Управление файлами) в меню Preferences (Предпоч-

тения) позволяет задать разное количество страниц публикации (вплоть до "всех") 

для отображения в Bridge в виде миниатюр. Это заметно облегчает поиск нужной 

публикации среди похожих документов. При этом надо помнить, что чем больше 

страниц выбрано для показа, тем дольше будет сохраняться файл публикации. 

Лучше найти разумный компромисс. 

Возможность просматривать миниатюры импортированных в документ 

InDesign изображений прямо в Bridge 

Bridge теперь позволяет просматривать импортированные в INDD-документ изо-

бражения без необходимости открывать документ в InDesign. Соответственно, ста-

новятся доступными метаданные этих изображений. 
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Кросс-медиа дизайн 

Интерактивные документы и презентации 

Чем дальше, тем больше становится значение интерактивных (и вообще электрон-
ных) публикаций. Расширение возможностей InDesign в данном направлении отра-

жает этот процесс. 

Импорт файлов форматов FLV и MP3 

В электронную публикацию теперь можно импортировать файлы в форматах Flash 
Video (FLV и F4V), сжатое видео (например, MP4) и SWF. К поддерживаемым  

аудиоформатам добавился MP3. Сохраняется поддержка старых медиаформатов — 
QuickTime (MOV), AVI, WMV. Однако использование FLV, F4V, MP4 и MP3 пред-

почтительно, поскольку обеспечивает наилучший результат при просмотре готовых 
материалов в последних версиях программ Acrobat, Adobe Reader и Adobe Flash 

Player. 

Палитра Media (Мультимедийные материалы) 

Палитра Media (Мультимедийные материалы) позволяет просматривать материалы 

в форматах SWF, FLV, F4V, MP4 и MP3 прямо в InDesign. Для файлов FLV, F4V и 
MP4 можно выбрать любой кадр и назначить его "основным" (отображаемым во 

время работы в качестве индикатора содержимого файла). Здесь же можно задать 
настройки проигрывателя для будущего интерактивного документа, создать меню, 

определить тайм-коды начала каждого эпизода и т. д. 

Палитра Animation (Анимация) 

Эта палитра позволяет настроить разнообразные эффекты движения и "оживления". 
Параметры, для которых можно задать изменения, традиционные: Position (Поло-

жение), Scale (Размер), Rotate (Поворот), Opacity (Непрозрачность). Можно ис-
пользовать готовые наборы настроек или создать свои собственные и сохранить их 

для дальнейшего использования. 

Здесь же задаются условия проигрывания каждой анимации — например, загрузка 
определенной страницы или щелчок в определенном месте. 

Готовые элементы анимации 

Готовые наборы настроек анимации привязаны к палитре Animation и позволяют 

быстро применять к страницам и их элементам часто используемые эффекты. Точ-
но такой же список эффектов можно найти в программе  Adobe Flash CS5 

Professional. Кроме того, в InDesign можно импортировать эффекты, созданные  
в Adobe Flash, что позволяет дополнительно усилить взаимодействие этих двух 

программ. 

Палитра Timing (Установка времени) 

Служит для настройки порядка проигрывания анимированных элементов публика-
ции. 

Палитра Object States (Версии объекта) 

Служит для создания нескольких версий одного и того же объекта. Например: 

можно создать один фрейм, имеющий 20 разных версий ("состояний"), каждая из 
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которых содержит новое изображение. При открытии пользователем конечного 

PDF- или SWF-файла он сможет с помощью кнопок "вперед" и "назад" просматри-

вать фотогалерею. 

Палитра Preview (Предпросмотр) 

Эта палитра позволяет проверить поведение интерактивных элементов публика-

ции — отдельного элемента, страницы или публикации в целом. 

Пикселы как поддерживаемая единица измерения 

До сих пор InDesign, как полиграфически ориентированный пакет, поддерживал 

единицы измерения, связанные с печатью: миллиметры, сантиметры, дюймы, пунк-

ты и т. д. Теперь, с усилением интереса к электронным публикациям, появилась 

возможность использовать, в том числе, и пикселы. Можно задать их как одну  

из единиц измерения в документе с помощью команды Preferences > Units & 

Increments (Предпочтения > Единицы измерения), можно (для конкретного объек-

та) явным образом прописывать их в поле единиц измерения контрольной панели, 

в диалоговых окнах различных команд и инструментов и т. д. 

При этом цифровые значения в соответствующих полях будут приводиться к це-

лым числам. 

Преобразование интернет-адресов в гиперссылки 

Команда Convert URLs To Hyperlinks (Преобразовать интернет-адреса в гипер-

ссылки) позволяет в выделенном фрагменте или во всем текстовом массиве нахо-

дить интернет-адреса и автоматически преобразовывать их в гиперссылки. К этой 

команде можно также привязать специальный стиль для оформления создаваемых 

ссылок. 

Улучшенный экспорт в формат SWF 

Операция экспорта в формат SWF теперь не только обрабатывает анимацию, видео, 

аудио и реакцию на действия пользователя, но и позволяет более тонко настраивать 

параметры готового SWF файла. 

Улучшенный экспорт в формат FLA (Flash Professional) 

В новой версии InDesign публикацию можно экспортировать напрямую в формат 

FLA для дальнейшего редактирования в Flash Professional. 

Дополнительные возможности экспорта в интерактивный формат PDF 

InDesign CS5 позволяет формировать два типа PDF файлов: интерактивный и для 

печати. Для экспорта в каждую из версий существует своя собственная команда и 

группа настроек. 

Все медийные составляющие публикации при экспорте из InDesign CS5 в интерак-

тивный PDF собираются на специальном слое, что обеспечивает наилучшее проиг-

рывание готового файла в Adobe Reader. Лучше всего, если исходные видеофайлы 

имеют формат FLV или F4V, а аудиофайлы — MP3. 

Дополнительные опции экспорта позволяют настраивать "изображение-заставку", 

параметры показа презентации, эффектные переходы между страницами и т. д. 
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Экспорт в XHTML формат 

Расширенные возможности экспорта в формат XHTML позволяют сделать более 
тесной интеграцию между InDesign CS5 и программами интернет-верстки (напри-
мер, Dreamweaver), что позволяет создать интернет-публикацию из INDD докумен-
та с максимально точным воспроизведением особенностей дизайна каждой стра- 
ницы. 

Новые возможности экспорта в формат JPEG 

Диалоговое окно Export JPEG получило новые возможности настроек — напри-
мер, выбор цветового пространства, возможность учесть припуски под обрез и т. д. 

Новые возможности совместной работы 

Подготовка крупной публикации — чаще всего коллективный процесс. Версталь-
щик работает с макетом, редактор вносит правки в содержание — от координации 
их действий в значительной степени зависит результат. Новая версия InDesign пре-
доставляет дополнительные возможности в этой области. 

On-line просмотр и комментарии 

В новой версии InDesign появился инструмент on-line просмотра и комментирова-
ния CS Review. С помощью палитры CS Review вы можете прямо в процессе вер-
стки размещать превью документа в сообществе Acrobat.com и получать коммента-
рии к своей работе. 

Отслеживание текстовых изменений 

Включив эту опцию (Track Text Changes), вы можете в режиме текстового редак-
тора (Story Editor) проследить основные изменения в тексте — вставку, удаление 
или перемещение текстовых фрагментов. 

Интеграция с редактором Buzzword 

InDesign позволяет работать с документами, созданными в программе Buzzword — 
популярном интернет-редакторе текстов. 

Режим презентации 

В версии CS5 появился новый режим просмотра — Presentation Mode (Режим пре-

зентации). Он близок к режиму Preview (Предпросмотр), но в нем полностью скры-
ты все элементы управления программой (меню и палитры), и на экране отобража-

ется одновременно только один разворот. Перемещение между разворотами проис-

ходит с помощью клавиш-стрелок. 

Цветная подсветка иконок страниц 

Палитра Pages позволяет задавать цветную подсветку иконкам страниц, тем самым 
облегчая их поиск. 

Комфорт и эффективность 

Кто не мечтал о том, чтобы работа над макетом шла легко, быстро и доставляла 
удовольствие? Команда Adobe многое сделала для воплощения этой мечты. 
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Фоновые задачи 

До сих пор при выполнении программой долгих задач — например, записи боль-
шого файла или экспорта документа в PDF — приходилось ждать окончания про-
цесса. Теперь же можно параллельно продолжать работать с документом, не тратя 
времени на ожидание. Кроме того, можно выстроить очередь из нескольких задач 
по экспорту в фоновом режиме и отслеживать их выполнение с помощью палитры 
Background Tasks (Фоновые задачи — Window > Utilities > Background Tasks). 

Клавиатурные сокращения для временной активизации инструментов 

Возможность, известная со старых версий (например, клавиша <Пробел> для вре-
менного вызова инструмента Рука), теперь расширена. Нужный инструмент вызы-
вается соответствующей клавишей и активен, пока эта клавиша нажата. Например, 
удерживание клавиши <U> позволяет временно переключиться с текущего инстру-
мента на инструмент Gap (Просвет), а отпуск ее снова вернет нас к текущему инст-
рументу. 

Палитра Tool Hints (Подсказки инструментов) 

Палитра Tool Hints (Window > Utilities > Tool Hints) показывает весь набор кла-
виш-модификаторов и результат их действия для текущего инструмента (рис. 1.11). 

 

Рис. 1.11. Палитра Tool Hints 
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Произвольный номер первой страницы 

При создании документа можно присвоить первой странице произвольный номер, 

не обязательно № 1. При этом если выбранный номер будет четным, то в режиме 

показа разворотов документ будет начинаться сразу с разворота, а не с одной стра-

ницы, как это всегда было до сих пор. 

Редактирование оригиналов для нескольких объектов сразу 

Применение команды Edit Original (Редактировать оригинал) к нескольким объек-

там активизирует соответствующие программы для каждого из них. 

Новые возможности работы с заблокированными объектами 

Заблокировать и разблокировать объект можно как в палитре Layers (Слои), так и в 

меню Object (Объект): Object > Lock (Объект > Заблокировать) и Object > Unlock 

All On Spread (Объект > Разблокировать все на развороте) соответственно. 

Новая опция Запрет выделения блокированных объектов в разделе Preferences 

(Предпочтения) меню Edit (Редактирование) позволяет разрешить или запретить 

выделение заблокированных объектов. 

Замена импортированных файлов на основе расширения 

Команда Relink file extension (Заменить по расширениям) контекстного меню па-

литры Links (Связи) позволяет заменить все файлы, имеющие определенное рас-

ширение, на аналогичные с другим расширением. Например, заменить все файлы 

JPEG на файлы TIFF. 

Скрытые объекты 

При необходимости можно скрыть часть объектов на странице с помощью команды 

Object > Hide (Объект > Скрыть). Скрытые объекты не печатаются, не экспор- 

тируются и не могут быть выделены. Для восстановления отображения объектов 

служит команда Object > Show All On Spread (Объект > Показать все на разво- 

роте). 

Фиксация режима Preview (Предпросмотр) в диалоговых окнах 

Теперь InDesign запоминает, был ли установлен для диалогового окна режим 

Preview, и автоматически восстанавливает выбранную установку при очередном 

открытии окна. 

Курсор импорта для перетаскивания файлов из Adobe Bridge 

В прошлых версиях при импорте перетаскиванием из Adobe Bridge или других 

файл-менеджеров изображение размещалось на странице с автоматическим созда-

нием фрейма по исходному размеру картинки. Теперь в процессе импорта создает-

ся Place cursor (Курсор импорта), позволяющий сразу задать необходимый размер 

фрейма. Пропорции фрейма фиксируются и соответствуют пропорциям изобра- 

жения. 

Округление значений CMYK-составляющих до целых чисел 

При перемещении бегунков в палитре Colour (Цвет) полученные значения автома-

тически округляются до ближайшего целого числа. 
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Очистка от направляющих 

В меню View > Grids & Guides (Вид > Направляющие и сетки) появилась новая 

команда Delete All Guides On Spread (Убрать все направляющие на развороте), 

позволяющая очистить экран от всех направляющих одним действием. 

Изменение масштаба документа при работе с диалоговыми окнами 

Теперь клавиатурные команды изменения масштаба <Ctrl><+>, <Ctrl><-> действу-

ют не только при основной работе с документом, но и при открытых диалоговых 

окнах. 

Новый шрифт по умолчанию 

Шрифт по умолчанию изменен с Times (Mac) и Times New Roman (Windows) на 

кросс-платформенную OpenType версию Minion Pro Regular. 

Фиксированное расположение окна текстового редактора 

InDesign запоминает заданные вами размеры и местоположение окна текстово- 

го редактора и при очередном открытии восстанавливает его в том же месте и со-

стоянии. 

Метки сгиба 

Если в установках печати выбрано Выводить обрезные метки, то метки сгиба пе-

чатаются сплошными линиями. 

Изменения в именах и расположении команд 

Некоторые команды меню изменили названия и переместились в другие разделы — 

см. приложение 1. 

Полезные ресурсы 

 Домашняя страница Adobe InDesign CS5: www.adobe.com/products/indesign; 

 Adobe TV: http://tv.adobe.com — видеоуроки по самым разным разделам про-

граммы и алгоритмам работы с ней; 

 Adobe Design Center: www.adobe.com/designcenter — статьи, уроки, галереи, 

дискуссии; 

 для тех, кто изучает продукты Adobe: www.adobe.com/education — подготовка 

к сертификации; 

 Adobe Forums: http://forums.adobe.com — обсуждение любых продуктов Adobe; 

 Adobe Labs: http://labs.adobe.com — обсуждение технологических тонкостей 

программных пакетов со специалистами из команды Adobe. 
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ПЕЧАТНЫЕ И ЭЛЕКТРОННЫЕ 

ПУБЛИКАЦИИ: СХОДСТВО И РАЗЛИЧИЕ 

 

 

 

 

Почему мы рассматриваем печатные и электронные публикации как отдельные, 

самостоятельные задачи, решаемые в рамках одного пакета? Дело в том, что воз-

действие готовой публикации на пользователя (читателя, зрителя) очень сильно 

зависит от того, к какому типу она принадлежит. Конечно, основа любой публика-

ции — текст. Пользователь, держащий в руках печатное или электронное изда-

ние, — прежде всего — читатель. Тем не менее физическая оболочка, в которую 

заключен этот текст, имеет огромное значение. 

Печатная публикация (иначе говоря, всем хорошо знакомые листовки, плакаты, 

буклеты, брошюры, журналы, книги) имеет одно важнейшее свойство: материаль-

ность. У книги или газеты, журнала или буклета есть формат, количество страниц, 

качество бумаги, вес, наконец. Физическое ощущение от перелистывания стра-

ниц — непременный элемент общения с печатной публикацией. Забота о сохранно-

сти печатного издания, работа с закладками, поиск и маркировка необходимой ин-

формации — все это необходимые читательские навыки, привычные настолько, что 

мы их обычно даже не замечаем. Более того, любое печатное издание посылает нам 

множество нетекстовых сигналов, которые мы улавливаем почти автоматически. 
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Глянцевая или матовая бумага? Плотная белая или рыхлая желтая, газетная? Мяг-

кий или твердый переплет у книги? Цветное или черно-белое оформление? Какое 

качество печати? Каков размер — можно ли читать это в транспорте, в толпе, на 

ходу, или необходимо разложить на подходящей поверхности? Сколько времени 

это должно быть актуально? И множество других вопросов, ответы на которые оп-

ределяют наше отношение к публикации, ее авторам и сообщению, которое она 

несет. Невозможно напечатать годовой отчет солидного банка на газетной бумаге 

расплывающимися красками в плохом переплете: статусные потери при этом будут 

многократно превышать экономию средств на издание. С другой стороны, нет 

смысла печатать на высококачественной бумаге газету ежедневных объявлений: 

уже завтра она превратится в макулатуру, и это приходится учитывать при выборе 

печатного материала. 

Поэтому при создании макета печатной публикации учитывается дальнейшее со-

трудничество с типографией. В зависимости от предполагаемого качества бумаги и 

используемой техники выстраивается работа с цветом; необходимость подрезки 

печатного блока до заданного формата накладывает определенные ограничения на 

расположение элементов макета; особенности полиграфических технологий дик-

туют использование команд и инструментов, применяемых только для подготовки 

макета к печати и ни для чего более. 

InDesign CS5 предоставляет множество возможностей для максимально полной и 

аккуратной подготовки макета к печати. Здесь и управление цветоделением, и учет 

требований типографии, и корректная работа с импортированными изображениями, 

и т. д. Этой задаче посвящена отдельная глава книги и проект, который позволяет 

разобраться во всех необходимых деталях процесса. 

Рассмотрим теперь публикацию электронную. 

Очевидно, главная ее особенность — абсолютная виртуальность. Все, что вы пред-

ложите вниманию читателя (зрителя), будет выведено на экран, будь то монитор 

компьютера, дисплей коммуникатора или электронная книга. Никакой бумаги, ни-

каких красок, никакой заботы о правильной обрезке по формату и подходящем пе-

реплете. Никаких сигналов, посылаемых внешним видом и материальной состав-

ляющей публикации: будь то "Гамлет" или сборник анекдотов, в руках у читателя 

все тот же электронный прибор. 

Но зато у нас появляются широчайшие возможности по использованию виртуаль-

ных средств воздействия. В электронную публикацию можно встроить аудио- и 

видеоролики; гиперссылки, позволяющие переходить к блокам нужной информа-

ции за один шаг; кнопки, формы и другие интерактивные элементы. Можно на-

строить существование публикации во времени, чтобы определенные медиа-

материалы появлялись и проигрывались в заданный момент; можно определить 

реакцию публикации на конкретные действия читателя или на результат работы 

других частей публикации. Словом, электронная публикация — своеобразный вир-

туальный мир, созданный для передачи информации "в чистом виде", но зато зна-

чительно расширяющий способы ее восприятия читателем. 
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